Advant® OCS
AC 100 OPC Server
Installation

System Version 6.0
NOTICE

This document contains information about one or more ABB products and may include a description of or a reference to one or more standards that may be generally relevant to the ABB products. The presence of any such description of a standard or reference to a standard is not a representation that all of the ABB products referenced in this document support all of the features of the described or referenced standard. In order to determine the specific features supported by a particular ABB product, the reader should consult the product specifications for the particular ABB product.

ABB may have one or more patents or pending patent applications protecting the intellectual property in the ABB products described in this document.

The information in this document is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this document.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license. This product meets the requirements specified in EMC Directive 2004/108/EC and in Low Voltage Directive 2006/95/EC.

TRADEMARKS

All rights to copyrights, registered trademarks, and trademarks reside with their respective owners.

Copyright © 2003-2014 by ABB.
All rights reserved.

Release: August 2014
Document number: 3BSE077523-600
# Table of Contents

## About This User Manual
- General ..............................................................................................................................9
- Installation of AC 100 OPC Server, Overview ..........................................................10
- User Manual Conventions ..........................................................................................10
- Feature Pack ................................................................................................................10
- Warning, Caution, Information, and Tip Icons .........................................................11
- Terminology ..................................................................................................................11
- Applicable Specifications ............................................................................................16
- Released User Manuals ...............................................................................................16

## Section 1 - AC 100 OPC Server Installation
- Site Planning ..................................................................................................................19
- Installation Procedures ...............................................................................................19
  - Recommended PC Performance and Capacity .......................................................20
  - Required Software ...................................................................................................20
  - Installing the PCI Board CI527A ........................................................................21
  - Software Installation ...............................................................................................22
  - Install Licenses .........................................................................................................22
  - Initial Configuration .................................................................................................25
  - Installation Verification (optional) ..........................................................................35
- Product Verification .....................................................................................................40
- AC 100 OPC Server Removal Procedure ..................................................................42
- Start-up Procedures .....................................................................................................43
- Shut-down Procedures ...............................................................................................44
- AC 100 OPC Server Upgrade Procedure to 6.0 .......................................................44
Index
**Safety Summary**

**Electrostatic Sensitive Device**
Devices labeled with this symbol require special handling precautions as described in the installation section.

**GENERAL WARNINGS**

<table>
<thead>
<tr>
<th>Equipment Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>All components, whether in transportation, operation or storage, must be in a noncorrosive environment.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Electrical Shock Hazard During Maintenance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disconnect power or take precautions to insure that contact with energized parts is avoided when servicing.</td>
</tr>
</tbody>
</table>

**SPECIFIC WARNINGS**

<table>
<thead>
<tr>
<th>Page -21</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut main power supply and read the instructions supplied with your PC’s documentation before you start to disassemble.</td>
</tr>
</tbody>
</table>

**SPECIFIC CAUTIONS**

<table>
<thead>
<tr>
<th>Page -20</th>
</tr>
</thead>
<tbody>
<tr>
<td>To avoid electrostatic discharge (ESD) damage to the CI board, we recommend that you exercise preventive maintenance precautions such as using a grounded wrist band and anti-static pad when handling the CI board and other electronic boards. Avoid skin contact with components.</td>
</tr>
</tbody>
</table>
About This User Manual

General

The product **AC 100 OPC Server** can be used without System 800xA to give third party clients access to Advant Controller 100 Series. This installation guide describes the installation of **AC 100 OPC Server** for third party clients, that is, a standard OPC Server for access to control systems based on Advant Controller 100 Series. AC 100 OPC Server supports also AF 100 routing for Control Builder A (see **Figure 1**).
Installation of AC 100 OPC Server, Overview

Section 1, AC 100 OPC Server Installation describes the installation of communication board CI527A and of the AC 100 OPC Server software. It describes both the corresponding hardware and the software installation procedures.

AC 100 OPC Server 6.0 is a further development of AC 100 OPC Server 5.1.

User Manual Conventions

Microsoft Windows conventions are normally used for the standard presentation of material when entering text, key sequences, prompts, messages, menu items, screen elements, etc.

Feature Pack

The Feature Pack content (including text, tables, and figures) included in this User Manual is distinguished from the existing content using the following two separators:

Feature Pack Functionality

<Object>

Feature Pack functionality included in an existing table is indicated using a table footnote (*) :

*Feature Pack Functionality

Feature Pack functionality in an existing figure is indicated using callouts.

Unless noted, all other information in this User Manual applies to 800xA Systems with or without a Feature Pack installed.
Warning, Caution, Information, and Tip Icons

This User Manual includes Warning, Caution, and Information where appropriate to point out safety related or other important information. It also includes Tip to point out useful hints to the reader. The corresponding symbols should be interpreted as follows:

- Electrical warning icon indicates the presence of a hazard which could result in electrical shock.
- Warning icon indicates the presence of a hazard which could result in personal injury.
- Caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard which could result in corruption of software or damage to equipment/property.
- Information icon alerts the reader to pertinent facts and conditions.
- Tip icon indicates advice on, for example, how to design your project or how to use a certain function

Although Warning hazards are related to personal injury, and Caution hazards are associated with equipment or property damage, it should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to personal injury or death. Therefore, fully comply with all Warning and Caution notices.

Terminology

A complete and comprehensive list of terms is included in System 800xA System Guide Functional Description (3BSE038018*). The listing includes terms and definitions that apply to the 800xA System where the usage is different from commonly accepted industry standard definitions and definitions given in standard dictionaries such as Webster’s Dictionary of Computer Terms. Terms that uniquely apply to this User Manual are listed in the following table.
## Table 1. Terminology

<table>
<thead>
<tr>
<th>Term/Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>Advant Controller, the common term for the series of controllers used in ABB automation systems, for example AC 160, AC 110.</td>
</tr>
<tr>
<td>AC 100</td>
<td>Advant Controller 100 Series - the ABB family of Controllers: AC 160, AC 110 and AC 70.</td>
</tr>
<tr>
<td>ActiveX®</td>
<td>Microsoft® standard for user interface components</td>
</tr>
<tr>
<td>Advant® OCS</td>
<td>The term refers to one or more of the open control systems from ABB, i.e., ABB Advant, ABB Master and ABB MOD 300.</td>
</tr>
<tr>
<td>Advant Fieldbus 100 (AF100)</td>
<td>Advant Fieldbus 100. AF100 is a high speed communication link intended for communication between controllers in the AC 400 and AC 100 series and other equipment adapted for the bus. The transmission rate is 1.5 Mbit/s and it supports three transmission media: twisted pair, coaxial and optical media.</td>
</tr>
<tr>
<td>AMPL</td>
<td>ABB Master® Programming Language. A function-block language with graphic representation which is especially developed for process control applications.</td>
</tr>
<tr>
<td>APB</td>
<td>Application Builder. The software module in CBA used to handle projects, nodes, circuits and type circuits.</td>
</tr>
<tr>
<td>Aspect</td>
<td>An aspect is a description of some properties of an Aspect Object. Some examples of aspects are name, circuit diagram, process display, and control logic.</td>
</tr>
<tr>
<td>Aspect Objects</td>
<td>A computer representation of a real object like a pump, a valve, an order or a virtual object like a service or an object type. An Aspect Object is described by its aspects and organized in structures.</td>
</tr>
<tr>
<td>BCB</td>
<td>Bus Configuration Builder. The software module in CBA used to create and maintain the Bus Configuration Database.</td>
</tr>
</tbody>
</table>
### Table 1. Terminology (Continued)

<table>
<thead>
<tr>
<th>Term/Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCD</td>
<td>Bus Configuration Database contains configuration data of nodes and busses on the AF100 network belonging to a project. The BCD is created and maintained with the CBA software and read by the OPC Server at start-up. File suffix is MDB.</td>
</tr>
<tr>
<td>BCI</td>
<td>Bus Configuration Interface. Internal interface to the Bus Configuration Database for the AC 100 OPC Server. Implemented according to Microsoft’s Component Object Model (COM).</td>
</tr>
<tr>
<td>Bus Master</td>
<td>A bus master is a device which administrates the information flow on the Advant Fieldbus 100</td>
</tr>
<tr>
<td>CBA</td>
<td>Control Builder A. Application building software for Advant Controller 100 and 400 series. Replaces the AMPL CC software. Comprises Application Builder (APB), Function Chart Builder (FCB), and Bus Configuration Builder (BCB)</td>
</tr>
<tr>
<td>CCA</td>
<td>Control Connection Aspect - defines the details about the connection.</td>
</tr>
<tr>
<td>CI</td>
<td>Communication Interface</td>
</tr>
<tr>
<td>CI Board</td>
<td>A CI board is a Communication Interface Board, used to connect a PC to the Advant Fieldbus 100 bus.</td>
</tr>
<tr>
<td>Client Application</td>
<td>A client application is an application which subscribes for data and/or sends commands to objects in the automation system.</td>
</tr>
<tr>
<td>Clock Master</td>
<td>A clock master is a device which distributes time on the bus to synchronize clocks in nodes on the Advant Fieldbus 100.</td>
</tr>
<tr>
<td>COM</td>
<td>Component Object Model, a specification that defines how individual software components can interact and share data under Windows. Developed by Microsoft.</td>
</tr>
</tbody>
</table>
### Terminology

#### DAT Based Objects
Object types with compared with the Extended DB Elements limited object support (DAT_AI, DAT_AO, DAT_DI, DAT_DO and DAT_DAT).

#### DB Element
DB element is an abbreviation for a data base element, which is part of a process control application. DB elements represent e.g. hardware boards (PM645...) or signals (AIS,DSP...).

#### DCOM
Distributed COM. Extends COM to networks.

#### DSP
DataSet Peripheral, a block of data to be transmitted on Advant Fieldbus 100. In the controller the DataSet Peripheral is represented with a database element.

#### EVS
Event Sets, the object type for transmitting time tagged events on the Advant Fieldbus 100 network.

#### Extended DB Elements
These object types offer complete support for the different object attributes.

#### FCB
Function Chart Builder, the graphic configuration and programming tool in CBA.

#### Function Chart
A function chart is a diagram for the representation of process control programs. It contains graphical symbols (rectangles) for PC elements and lines for connections between element terminals.

#### HMI
Human Machine Interface.

#### HSI
Human System Interface.

#### Installation media
AC 100 OPC Server 6.0 has its own distribution media.

#### LED
Light Emitting Diode. LEDs are often used as indicators on control panels.

---

**Table 1. Terminology (Continued)**

<table>
<thead>
<tr>
<th>Term/Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAT Based Objects</td>
<td>Object types with compared with the Extended DB Elements limited object support (DAT_AI, DAT_AO, DAT_DI, DAT_DO and DAT_DAT)</td>
</tr>
<tr>
<td>DB Element</td>
<td>DB element is an abbreviation for a data base element, which is part of a process control application. DB elements represent e.g. hardware boards (PM645...) or signals (AIS,DSP...).</td>
</tr>
<tr>
<td>DCOM</td>
<td>Distributed COM. Extends COM to networks.</td>
</tr>
<tr>
<td>DSP</td>
<td>DataSet Peripheral, a block of data to be transmitted on Advant Fieldbus 100. In the controller the DataSet Peripheral is represented with a database element.</td>
</tr>
<tr>
<td>EVS</td>
<td>Event Sets, the object type for transmitting time tagged events on the Advant Fieldbus 100 network.</td>
</tr>
<tr>
<td>Extended DB Elements</td>
<td>These object types offer complete support for the different object attributes.</td>
</tr>
<tr>
<td>FCB</td>
<td>Function Chart Builder, the graphic configuration and programming tool in CBA.</td>
</tr>
<tr>
<td>Function Chart</td>
<td>A function chart is a diagram for the representation of process control programs. It contains graphical symbols (rectangles) for PC elements and lines for connections between element terminals.</td>
</tr>
<tr>
<td>HMI</td>
<td>Human Machine Interface.</td>
</tr>
<tr>
<td>HSI</td>
<td>Human System Interface.</td>
</tr>
<tr>
<td>Installation media</td>
<td>AC 100 OPC Server 6.0 has its own distribution media.</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode. LEDs are often used as indicators on control panels.</td>
</tr>
</tbody>
</table>
Table 1. Terminology (Continued)

<table>
<thead>
<tr>
<th>Term/Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object (Process)</td>
<td>Object (Process) is a physical or calculated process object, or a functional unit or type circuit containing all related inputs and outputs. An example of a process object is an analog input including value, limits, status, etc. There are two kinds of objects, Extended DB Elements and DAT based objects</td>
</tr>
<tr>
<td>MMI</td>
<td>Man Machine Interface.</td>
</tr>
<tr>
<td>OPC</td>
<td>An application programming interface from the OPC Foundation. The application of the OPC standard interface makes possible inter operability between automation/control applications, field systems/devices and business/office applications.</td>
</tr>
<tr>
<td>PC</td>
<td>An abbreviation for both personal computer and process controller.</td>
</tr>
<tr>
<td>PC element</td>
<td>PC element is an abbreviation for process control element, which is part of a process control program. PC elements are represented by rectangles in a function chart and by corresponding callnames in a tree diagram</td>
</tr>
<tr>
<td>PC program</td>
<td>PC program is an abbreviation for process control program.</td>
</tr>
<tr>
<td>PG 2</td>
<td>Process Graphics 2, the default graphics system in 800xA.</td>
</tr>
<tr>
<td>System 800xA</td>
<td>A collection of software that forms the basis for an IndustrialIT System, and provides the development and execution environment for IndustrialIT Compliant applications. Included is the functionality for efficient control and supervision of an automated process; key functions are presentation of process graphics, process dialogs and presentation of alarms and trends.</td>
</tr>
</tbody>
</table>
### Applicable Specifications

The communication board CI527A meets the requirements specified in 2004/108/EC and in Low Voltage Directive 2006/95/EC.

### Released User Manuals

*Table 2* lists the documentation related to AC 100 OPC Server Installation. A Release Note in the *pdf* format is included in the delivered installation media.

#### Table 2. Related Documentation

<table>
<thead>
<tr>
<th>Category</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>Advant Fieldbus 100 User Manual (3BSE000506*)</td>
<td>Describes how to use the AF100 Network. It also provides a technical description of communication boards and modems available.</td>
</tr>
<tr>
<td></td>
<td>Advant® OCS, Control Builder A Installation (3BSE066174*)</td>
<td>Describes how you install the Control Builder A product and the Control Builder A Interface to Aspect Integrator Platform / System 800xA.</td>
</tr>
</tbody>
</table>

---

**Table 1. Terminology (Continued)**

<table>
<thead>
<tr>
<th>Term/Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>A data field on an aspect of an Aspect Object that can be accessed through OPC. A data field on an <em>ActiveX</em> control accessible from the Visual Basic editor.</td>
</tr>
<tr>
<td>SDP</td>
<td>Service Data Protocol used to send messages on the Advant Fieldbus 100 network.</td>
</tr>
<tr>
<td>XDB</td>
<td>Extended DB Elements (AIS, AOS, DIS, DOS, MB, MBS, MI, MIL, MR)</td>
</tr>
</tbody>
</table>
### Table 2. Related Documentation (Continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>800xA for AC 100/Advant® OCS, AC 100 OPC Server, Configuration and Operation (3BDS013988*)</td>
<td>Describes how you can configure and use AC 100 OPC Server.</td>
</tr>
<tr>
<td></td>
<td>Advant® OCS, AC 100 OPC Server, Installation (3BSE077523*)</td>
<td>Describes how to install AC 100 OPC Server (this book).</td>
</tr>
<tr>
<td></td>
<td>Application Builder User Guide (3BDS100560*)</td>
<td>Describes installation of Control Builder A components and contains the operation instruction of Application Builder.</td>
</tr>
<tr>
<td></td>
<td>Bus Configuration Builder User's Guide (3BDS100312*)</td>
<td>Describes bus configuration support functions for Advant Fieldbus 100.</td>
</tr>
<tr>
<td></td>
<td>Function Chart Builder User's Guide (3BDS100595*)</td>
<td>Describes how Function Chart Builder can be used to configure different target systems.</td>
</tr>
<tr>
<td></td>
<td>System 800xA, Tools (2PAA101888*)</td>
<td>Describes the procedure to access the ABB Start Menu.</td>
</tr>
</tbody>
</table>
Table 2. Related Documentation (Continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>AMPL Configuration Advant Controller 100 Series Reference Manual (3BSE009626*)</td>
<td>Contains instructions about configuration and application programming, fault tracing and maintenance of Advant Controller 160/110/70.</td>
</tr>
<tr>
<td></td>
<td>PC Elements Control Builder A Advant Controller 160 Series Reference Manual (3BDS005557*)</td>
<td>Contains instructions and the data sheets for all PC Elements available for Advant Controller 160/110/70.</td>
</tr>
<tr>
<td></td>
<td>PC Elements Control Builder A Advant Controller 110 Series Reference Manual (3BSE000504*)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PC Elements Control Builder A Advant Controller 70 Series Reference Manual (3BSE009177*)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Data Base Elements Advant Controller 160 Reference Manual (3BDS005556*)</td>
<td>Contains instructions and the data sheets for all data base elements available for Advant Controller 160/110/70.</td>
</tr>
<tr>
<td></td>
<td>Data Base Elements Advant Controller 110 Reference Manual (3BDS100594*)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Data Base Elements Advant Controller 70 Reference Manual (3BDS100593*)</td>
<td></td>
</tr>
</tbody>
</table>
The Installation procedures described in this section are the same for the two different cases of AC 100 OPC Server usage:

- Use of AC 100 OPC Server with a third party OPC client
- Use of AC 100 OPC Server (AF 100 Interface) to connect Control Builder A to AC 100 controllers via Advant Fieldbus 100.

Site Planning

When you do site planning, it is important that you check that requirements for environmental conditions (temperature, humidity, chemical), grounding and power supply are met, according to standards for your application. These requirements are stated in the hardware documentation for your PC and in the *Advant Fieldbus 100 User Manual (3BSE000506)*.

Installation Procedures

This chapter covers the installation and setup of the AC 100 OPC Server, from now the OPC server. The OPC server 6.0 requires a CI527A as communication board.

You will find the following installation instructions in this chapter:

- Installation of the CI527A board.
- Installation steps for the AC 100 OPC Server software.

For a description of how to connect the modem to the AF100 network, see the *Advant Fieldbus 100 User’s Guide*.

Only one communication board is supported per PC and AC 100 OPC Server.
Recommended PC Performance and Capacity

The personal computer must be equipped with a half length PCI slot for installation of a CI527A PCI board.

Recommended performance and capacity of the PCs for different node types can be found in the IndustrialIT Certification web portal.

Required Software

Table 3. Required Software

<table>
<thead>
<tr>
<th>Required Software for installation of AC 100 OPC Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 8.1 Professional or Windows Server 2012 R2, 64 bit. The supported Service Pack versions are defined in the Release Notes.</td>
</tr>
<tr>
<td>ABB 800xA Common 3rd Party Install (version 6.0).</td>
</tr>
<tr>
<td>ABB Central Licensing System (CLS) has to be installed (Version: CLS 6.0).</td>
</tr>
</tbody>
</table>
Installing the PCI Board CI527A

Follow the mounting instructions below and the instructions in your PC manual regarding how to add cards on the PCI bus.

Cut main power supply and read the instructions supplied with your PC’s documentation before you start to disassemble.

Install the PCI board as follows:
1. Disconnect the PC’s main power supply.
2. Open up the PC’s chassis and locate an empty PCI bus slot.
3. Remove the cover bracket.
4. Insert the board firmly into place and secure the board bracket.
5. Close the PC’s chassis and Connect cables and terminator according to Figure 2.

6. Reconnect the main power supply and reboot your PC.

![Diagram of CI527A Connections]

*Figure 2. CI527A Connections*
Software Installation

- Make sure you have administration privileges before starting the installation.
- Note that in all cases the ABB 800xA Common 3rd Party Install and the ABB Central Licensing System (CLS) has to be installed on the computer where the OPC Server will run before installation of the OPC Server is started.

Follow these steps to install the AC 100 OPC Server:

1. If applicable, uninstall previous version of AC 100 OPC Server.
2. Log on the computer as a user with administration privileges.
3. Insert the installation media and open the Windows Explorer.
4. Install the ABB 800xA common 3rd party software using the Setup.exe from the ABB 800xA Common 3rd Party Install folder.
5. Install ABB Central Licensing System (CLS) from the Licensing folder.¹
6. Install AC 100 OPC Server using ABB_AC_100_OPC_Server.bat from the AC 100 OPC Server folder.
7. The AC 100 OPC Server and the CI527A card are successfully installed and you are now ready for the Install Licenses and Initial Configuration.

Install Licenses

You must own AC 100 OPC Server licenses (.SLA file) and load them into the licensing system with the ABB License Entry tool:

Open the License Entry application and then select File > Load / Replaces Licenses (see Figure 3).

To make the added licenses available for the affected clients:

- Shut down ABB License Server

¹ Additional information for AC 100 OPC Server for installation of Central Licensing System (CLS), refer to System 800xA 6.0 Manual Installation (2PAA112455*).

Installation alternatives:
For a single node AC 100 OPC Server system, refer to chapter CLS Standalone Option.
For a system with redundant AC 100 OPC Server nodes, install the CLS Server in a separate PC.
Refer to License Server Setup and Internet Information Services. For all other nodes, refer to License Client.
• Shut down the affected clients
• Restart the ABB License Server
• Restart the affected clients

![ABB License Entry](image)

**Figure 3. ABB License Entry tool**
**Needed Licenses for AC 100 OPC Server**

When AC 100 OPC Server is used **without System 800xA** but with a third party OPC Client there must be OPC specific tag licenses in the license group **ABB AC 100 OPC Server**:

If you run a pair of two redundant OPC Servers you must have a license feature **AC100_OPC_TAGS_RED**, if you run a single OPC Server you must have a licenses feature **AC100_OPC_TAGS** with an appropriate tag count. The tag count corresponds to the number of exposed objects as inserted by the OPC Server in the Windows Event log under EventId 4001 at end of configuration phase (see **Initial Configuration** on page 25).

If you run several single OPC Server you must add the **AC100_OPC_TAGS**, if you run several redundant pairs you must add the **AC100_OPC_TAGS_RED**. You can also mix single and redundant OPC Server and have both feature licenses. See following sample for a mixed environment with two redundant OPC Server pairs and one single OPC Server.
Initial Configuration

This section describes the procedure for configuring services, performing firewall settings and configuring the OPC Server using the Configuration Wizard.

Service Configuration

1. Open the Control Panel and select Administrative Tools > Services (see Figure 6).
2. Select the ABB AC 100 OPC server properties and click on the Log On tab.
3. Click This Account and specify the applicable user account and password. The user must have Administrative privileges.
4. Select ABB AC 100 VFI Server and ABB AC 100 CI52x manager and make the same account settings.
Firewall Settings

If the OPC Server will be accessed by a remote OPC client via DCOM and the Windows Firewall is On, add program wiaopc.exe to the Firewall Exceptions.

Configuration Wizard

Use the Configuration Wizard to do all the configuration of the OPC server. Execute the following procedure for the configuration:

1. If System 800xA is already installed, select the Configuration Wizard from the ABB Start Menu.
2. Select AF100 Network and click Next.
3. Set **Bus number** and **Bus Length**, click **Next** to continue.

**Bus Number**

0-255. Use the same bus number as you use in the CBA application.

**Bus Length**

You can choose between three pre-defined bus length intervals (2000, 8500 and 15000 meters). To know which bus length to select you need to know the details of your AF100 network installation. The selection is up to maximum length, so for most systems 2000 meters will be sufficient.

**Note:** AC110 and AC160 support only 2000 meters
Figure 8. Configure PCI Device Parameters

4. Set the **Bus Parameters** and select the **Time Synchronization**.

   Set **Station Number** to a unique number.

   **Bus Parameters:**

   Select the **Bus Master** check box. There are only a few exceptions with large AF100 networks where it might be an advantage not to check it.

   Check the **Redundant Line Support** if redundant AF100 cables are used.

   **Time Synchronization:**

   Time synchronization enables the Advant Fieldbus 100 user to time synchronize all stations connected to the Advant Fieldbus 100 network. Possible configuration modes are: None, Master, Backup or Slave.

   **None:** No time synchronization is performed against the AF100 bus.

   **Slave:** The AC 100 OPC Server keeps the PC clock synchronized to the time received from AF100.
**Master or Backup:** AC 100 OPC Server permanently monitors AF100 for a time master.

If a time master on AF100 bus is detected, it will act as a **Slave**.

Otherwise, it will act as **time master**, that is, it will retrieve the time from the Windows operating system and distribute it on AF100 bus.

The AF100 Diagnostic tool displays the configured mode as well as the current state of time synchronization See Figure 20.

Both time synchronization and OPC Server redundancy requires that Bus Master is checked to work correctly.

For more information on setting up daylight saving and time synchronization please refer also to **Set up daylight saving and time synchronization** on page 59.

Only one station on the AF100 bus may be set to time synchronization Master. Only one AC 100 OPC Server may be configured to time synchronization Backup.

If a Backup node becomes Master or vice versa this is not saved permanently. At restart the AC 100 OPC Server will go back to the original configured time synchronization mode.

Select the **Keep server running** check box to keep the server software and the communication board CI527A running even when all clients applications have been closed. This will speed up client restarts.
5. Click **Next** and then click **Finish** in the Apply Settings dialog.

6. In the **Configuration Wizard**, select **AC 100 OPC Server Definitions** and click **Next**. The OPC Server Configuration dialog appears.
Section 1  AC 100 OPC Server Installation

Initial Configuration

7. Enter the path to the Bus Configuration Database (BCD) and some other applications.

The **BCD path** is a file path available in the Application Builder (part of Control Builder A) accessible through **Help > On Project**.

The path consists of the shown Project Root extended by a backslash ("\") and the Project Name. In the example shown in Figure 11 the BCD path is `c:\pro\acptt17`.

If the path is placed on a network disk you must define a user login for the Advant OPC Server that has access rights to that disk.

Placing the BCD on a network device is convenient during commissioning for redundant OPC server, which have in this case always the same data source. Restarting the OPC Server is not possible, if the network device is not available. As the redundancy is threatened by a single failure, it is recommended to copy the BCD to a physical drive of the OPC Server PC, after the commissioning phase.

*Figure 10. AC 100 OPC Server Configuration Dialog*
If the Bus Configuration Database (BCD) for configuration of the AC 100 OPC Server does not reside in the same PC as the AC 100 OPC Server, that is in a domain environment, you must have/create a domain user account with access rights to the shared drive holding the BCD. If running in 800xA, the 800xA service account shall be used. This user must also be granted administrator privileges on the local machine.

If you use a distributed BCD, the path must be specified using UNC notation, for example, \Server1\projects.

![Application Builder dialog](image)

**Figure 11. Application Builder dialog Help>On Project**

Set the **Application Version Supervision** to the interval length in seconds that you want between each check of Controller database changes (due to CBA changes).

Set the **Event enabling cycle time** to the interval required between each Enable Event message sent to controllers. The Enable Event message is required by the restarted controller to send alarms and events to the OPC Server.

Select the **Enable** check box in **Dynamic AIS Alarm Limits** if you want the OPC Server to always have AIS-alarm limit items (for example, HI2_LIM) synchronized with the controller.

If the check box is not selected, the AIS alarm limits will be read only at start-up.
This information is applicable for **Dynamic AIS Alarm Limits**.

The OPC-server will read the limits from the controller when an AIS-alarm limit item is added to an OPC-group. In run-time the alarm limits are updated via controller sent Event Sets. The disadvantage with usage of this feature is increased bus load due to Service Data traffic and in worst case, subscription timeouts in client applications. If there are more than ten AIS Bargraphs present in the one process display the suggestion is not to use this feature, or use bargraphs without limit presentation.

If there is a redundant pair of OPC Servers in your configuration specify the IP-address of the other OPC Server at **Redundant OPC Server IP**.

8. Click **Next** and then click **Finish** to set your choices..

9. In the **Configuration Wizard**, select **AC 100 OPC Server Station Filtering** and click **Next**.

---

**Figure 12. Configuration Wizard Dialog - Choose OPC Server Filtering**
10. The OPC Server Filtering dialog will appear. Select the stations to be visible in the OPC Server.

![Configuration Wizard dialog - Select Stations to be Visible](image)

*Figure 13. Configuration Wizard dialog - Select Stations to be Visible*

Stations of type OPC cannot be filtered. They are always exposed by the AC 100 OPC Server.

11. Click Next and then click Finish to set your choices. The system prompts for a restart of the PC (see Figure 14).

---

1. The stations listed in the ’Filtering of OPC Server’ dialog are the stations stored in the BCD for the corresponding bus number. This dialog is empty until the BCD path is defined and the computer is restarted. The controller stations in the BCD come from nodes (with DB Elements for AF 100 communication interfaces) created in Application Builder and from OPC stations created in Bus Configuration Builder. You can see these stations also in the left window of Bus Configuration Builder under the appropriate bus number.
12. Click **OK** and manually restart the PC.

**Installation Verification (optional)**

After you have performed the software and hardware installation you are recommended to verify that the AC 100 OPC Server has been properly installed. To accomplish this, do the following:

1. Verify that the AC 100 OPC Server utilities are available, for example, **About OPC Server**.

2. Open the **Control Panel** and select **Programs and Features** to view if ABB AC 100 OPC Server is properly listed here.

3. Check the Windows **Device Manager** and make sure that the CI527A device and Driver are not working properly. The **Device Manager** is started through **Control Panel > System > Device Manager**.
To find the CI527A Driver choose **View > Devices by type** in the Device Manager and expand the **AF100** icon.

![Device Manager](image)

*Figure 15. Windows Devices*
4. Right-click on the CI527A Driver and choose **Properties**.

![CI527A Properties](image)

*Figure 16. CI527A Properties*
5. Select the Details tab to find the correct version of the CI527A board: This must be \textbf{DEV\_0862} as shown below.

![Figure 17. Details of CI527A Properties](image)

6. Verify that the services
   a. ABB AC 100 CI52X Manager
   b. ABB AC 100 OPC Server
   c. ABB AC 100 VFI Server
are listed and running by selecting \textbf{Control Panel > Administrative Tools > Services}, see \textbf{Figure 21}.

   Also check that the correct service account is used, see \textbf{Figure 6}.

7. Verify that the processes
   a. wiaopc.exe
   b. wiaci526.exe
   c. wivserver.exe
are listed and running by right-click on the start bar and selecting \textbf{Task Manager > Processes}. 
8. Check the Windows Event Viewer to ensure that no fatal errors are reported from the ABB AC 100 OPC Server by selecting Control Panel > Administrative Tools > Event Viewer > Windows Logs > Application.
Product Verification

After you have performed the initial configuration of the AC 100 OPC Server, you are recommended to verify that the software has been properly configured and that the system has contact with the Advant Fieldbus 100 network. To accomplish this, do the following:

It is not supported to run AC 100 OPC Server without the CI527A board properly installed.

1. Select **About AC 100 OPC Server** (see Figure 19) from the ABB Start Menu. The status icon must be

![Figure 19. Example of About AC 100 OPC Server](image)

2. Verify that the board is operational and all stations are reachable by viewing the Diagnostics. Select **AF 100 Diagnostics** from the ABB Start Menu, see Figure 20. For more information about the Diagnostics function please refer to the *800xA for AC 100/Advant® OCS, AC 100 OPC Server Configuration and Operation (3BDS013988*)*. 
3. Check the Windows Event Viewer to ensure that no fatal errors are reported from the **ABB AC 100 OPC Server**.

   If the recommended verifications show problems, you can check the hardware of the CI527A by doing the following:

   a. Check that the green P (power) is lit.
b. Check that the yellow RX (receive) LED is lit (if other stations on the Advant Fieldbus 100 network are up and running).

c. When the Advant Fieldbus 100 Interface is started, check that the yellow TX (transmit) LED starts to blink.

**AC 100 OPC Server Removal Procedure**

Removal removes the installed product from your machine, i.e. it removes:

- Files
- Registry entries
- Environment variables
- Start-menu icons
- Registrations of ActiveX components.

Removal steps:

1. Stop all OPC clients, such as "About AC 100 OPC Server" and other 3rd party clients; otherwise the OPC server will be restarted automatically.

2. Stop all three ABB AC 100 services from the Computer Management. See Figure 21.

To be able to perform a removal, you need to have administrator privileges.

The stop request sometimes times out. Use the Windows Task Manager to verify that the process **wiaopc.exe** is no longer running.
Section 1  AC 100 OPC Server Installation

Start-up Procedures

3. Uninstall **ABB AC 100 OPC Server** from Programs and Features.

   You will be requested to confirm the removal once more, click **Yes** and then wait for the removal to take place.

**Verifying the Removal**

After you have removed the AC 100 OPC Server, verify that the **ABB AC 100 OPC Server** Service is no longer listed in the Services dialog in the **Control Panel** (see **Figure 21**).

**Start-up Procedures**

The AC 100 OPC Server is implemented as a Windows service (**ABB AC 100 OPC Server**) and is automatically started when Windows is started. If you have to change the start-up configuration, then modify the settings in Services.

Observe that redundant OPC Servers have to be started sequentially.
Shut-down Procedures

The AC 100 OPC Server is implemented as a Windows service (ABB AC 100 OPC Server) and is automatically stopped when Windows is shut down. If you have to change the shut-down configuration, then modify the settings in Services.

AC 100 OPC Server Upgrade Procedure to 6.0

Perform the following steps before shutting down the system to be upgraded:

- Document the configuration done in the Configuration Wizard, action AF100 Network, AC 100 OPC Server Definitions, and AC 100 OPC Server Station Filtering.

Perform the following steps in the system where AC 100 OPC Server will be installed:

- Install AC 100 OPC Server 6.0 as described in Installation Procedures on page 19.
- Restore the configuration as specified previously, in the Configuration Wizard.
- Restart the system.
Index

A
ABB Master Programming Language 12
AC 12
ActiveX 42
Advant Controller 12
Advant Fieldbus 100 12
Advant OCS 12
AF100 12
AMPL 12
APB 12
Application Builder 12

B
BCB 12
BCD 13
BCI 13
Bus Configuration Builder 12
Bus Configuration Database 13
Bus Configuration Interface 13
Bus Length 27
Bus Master 13

C
CBA 13
CI Board 13
CI527A
   Connection drawing 21
Client Application 13
Clock Master 13
CLS (ABB Central Licensing System) 20
COM 13
Component Object Model 13
Configuration Wizard 26

D
DAT Based Objects 14
DataSet Peripheral (DSP) 14
DCOM 14
Distributed COM 14
DSP 14

E
EISA 13
Environment 19
Event enabling cycle time 32
Event Sets 14
EVS 14
Extended DB Elements 14, 16

F
FCB 14
Function Chart 14
Function Chart Builder 14
Index

H
HMI 14
HSI 14
Human Machine Interface (HMI) 14
Human System Interface 14

L
LED 14
Light Emitting Diode 14

M
Man Machine Interface 15
MMI 15

O
Object (Process) 15
OPC 15

P
PC 15
PC Element 15
PC Program 15
PCI
   Installing the board 21
Personal Computer 15

S
SDP 16
Service Data Protocol (SDP) 16

X
XDB 16